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ABSTRAK

Rebakan bandar yang masih lagi berlaku pada masa kini menyebabkan
ketidakseimbangan pembangunan antara kawasan bandar dan luar bandar. Isu seperti
penggunaan tanah secara tidak optimum, penyelerakan pembangunan guna tanah,
penukaran guna tanah kepada kegunaan perbandaran serta pengurangan kawasan hutan
dan pertanian menyebabkan kesukaran urus tadbir dan penguatkuasaan yang berkesan.
Bukan itu sahaja, kedudukan kampung dalam bandar semakin terancam akibat daripada
rebakan bandar yang berlaku. Pada masa kini, visualisasi yang sedia ada hanya terhad
kepada sempadan bandar dan sempadan kampung sahaja. Visualisasi sedia ada tidak
dapat memaparkan sempadan kampung dalam bandar seperti yang diperlukan. Hal ini
kerana data sedia ada hanya dapat memberikan sempadan bandar dan sempadan
kampung sahaja. Kajian ini dijalankan bagi menghasilkan visualisasi sempadan
kampung dalam bandar bagi membantu agensi membuat keputusan dalam merangka
perancangan pembangunan terutama untuk kawasan kampung dalam bandar dan
menilai keberkesanan visualisasi tersebut di /dalam perbincangan kumpulan fokus
(Focus Group Discussion, FGD). Pendekatan yang digunakan adalah dengan membuat
integrasi data menggunakan perisian Rapidminer dan membangunkan papan pemuka
menggunakan perisian Tableau yang bukan sahaja merangkumi maklumat statistik
tetapi juga maklumat persempadanan bandar, kampung dan kampung dalam bandar.
Data-data mentah sedia ada dalam format shapefiles, excel dan comma-separated
values diproses dan diintegrasikan sebelum papan pemuka dapat dibangunkan. Kajian
ini merupakan kajian rintis bagi dua negeri sahaja‘iaitu.di Negeri Sembilan dan Melaka.
Hasil daripada kajian ini‘telah dapat membuktikan kewujudan kampung dalam bandar
secara visual yang mana sebelum ini tidak dapat lagi-disahkan dalam bentuk peta grafik.
Selain itu hasil ujian oleh FGD berdasarkan tiga elemen seperti reka bentuk papan
pemuka, interaksi papan pemuka dan visualisasi.data mendapati pembangunan papan
pemuka ini adalah baik dan dapat. memberikan informasi yang diperlukan. Di samping
itu, kajiandini didapati membantu pengurusan agensi membuat keputusan dengan lebih
baik dan tepat, kajian ini akan.memberi manfaat kepada orang awam iaitu penduduk
yang tinggal di dalam kawasan sempadan kampung dalam bandar. Tidak kurang juga,
daripada sudut ilmiahnya, kajian ini boleh diterokai lagi kepada visualisasi rebakan
bandar yang berlaku di samping menerapkan analisis ramalan untuk menentukan
keperluan kemudahan pendidikan dan kemudahan kesihatan di satu-satu kawasan.



VISUALIZATION OF VILLAGE BOUNDARIES WITHIN CITY USING TABLEAU

ABSTRACT

The urban sprawl that is still happening today is causing an imbalance in development
between urban and rural areas. Issues such as non-optimal land use, dispersal of land
use development, conversion of land use to municipal use as well as the reduction of
forest and agricultural areas causing difficulties in effective governance and
enforcement. Not only that, the village in the city is increasingly threatened as a result
of the urban sprawl. Currently, the existing visualizations are limited to city boundaries
and village boundaries only. It cannot shows the boundaries for village in the city area.
This is because the village boundary area in the city cannot be determined clearly when
the existing data only provide the city boundary and the village boundary only. This
study was conducted to produce a visualization of village boundaries in the city to help
agencies make decisions in formulating development plans, especially for rural areas in
the city and evaluate the effectiveness of the wvisualization in the Focus Group
Discussion (FGD). The approach used is to develop a dashboard using Tableau software
that not only includes statistical information but also urban, rural and village in the city
boundary information. The existing raw data in shapefiles, excel and comma-separated
values formats are processed.and integrated before the dashboard can be developed.
This study is a pilot study for two states only which are Negeri Sembilan and Melaka.
The results of this study have been able to prove the existence of villages in the city
visually which previously could.not be confirmed. in.the form of graphic maps. In
addition, the results of the FGD test based on three elements such as the design of the
dashboard, interaction.of the dashboard and data visualization found that the it was good
and could provide the necessary information. Besides helping the agency management
to make better-and more accurate decisions, this'study will also benefit the public that
live within the village boundary area in the city. On the other hands, from a scientific
point of view, this study can be further explored to visualize the urban sprawl that occurs
and also to apply predictive analysis in order to determine the needs of educational
facilities and health facilities in the area.
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BAB |

PENDAHULUAN

11 PENGENALAN

Big Data atau Data Raya kini telah menjadi satu. perkembangan dunia yang
memungkinkan revolusi industri dan pembuatan keputusan. Hal ini telah menjadi
tarikan kepada bukan sahaja ahli akademik-tetapi juga golongan profesional dalam
sektor industri. Yusuf (2019) memberi tanggapan Data Raya sebagai paradigma sains
keempat dan dikenalpasti sebagai« perkara besar seterusnya dalam inovasi oleh
Machairidou (2018). Bobriakov (2018) juga menyatakan Data Raya menjadi pencetus
kepada revolusi pengurusan dan membawa revolusi dalam sains dan teknologi.
Sehingga tahun 2020, dunia telah dianggarkan menjana 52 kali ganda data yang ada
pada tahun 2010 dan 76 kali ganda sumber maklumat pada masa yang sama (Nikhat et
al. 2020). Tidak-boleh dinafikan lagi pada masa kini, Big Data atau Data Raya telah
secara langsung memberi impak kepada perkembangan dunia maklumat masa Kini

dalam<semua sektor.

Perkembangan Data Raya masa Kini dilihat juga memberi kesan kepada
perkembangan perancangan fizikal negara. Hal ini dapat dilihat di mana di dalam
sesebuah bandar itu akan mempunyai satu sistem yang kompleks merangkumi interaksi
di antara aspek pengangkutan, gunatanah, persekitaran dan populasi pada pelbagai skala
sama ada di peringkat global, nasional, perbandaran mahupun kejiranan. Kemampanan
pembangunan sesebuah bandar itu memerlukan bukti saintifik bagi memahami sistem
tersebut dan menjangkakan kebolehupayaannya untuk jangka masa pendek dan jangka
masa yang panjang. Sehubungan itu, agensi kerajaan telah mula bergerak dalam
memanfaatkan Data Raya bagi menyokong pembangunan dan kemampanan bandar

yang sejahtera dapat dilestarikan.



Pada 26 April 2017, Dasar Perancangan Fizikal Desa Negara 2030 (DPF Desa
Negara 2030) mendapat kelulusan di peringkat Majlis Perancang Fizikal Negara
(MPEN) dan seterusnya YAB Perdana Menteri telah melancarkan DPF Desa Negara
2030 bersama-sama dengan Dasar Perbandaran Negara Kedua (DPN2) dan Rancangan
Fizikal Negara Ketiga (RFN3) pada 8 Jun 2017. DPF Desa Negara ini merupakan dasar
pembangunan desa yang pertama di Malaysia berbentuk ‘Spatial and Operational Plan’
merangkumi aspek sosial, ekonomi, infrastruktur, alam sekitar, utiliti, pengangkutan,

warisan, pengurusan dan mekanisma pemantauan (DPF Desa Negara 2030).

Menurut DPF Desa Negara 2030, kampung.didefinisikan sebagai “sebuah
petempatan tradisi di kawasan desa, terdiri daripada sekumpulan rumah serta
mempunyai ciri-ciri tradisional yang tinggi dari segi sosio-budaya dan fizikal”. Jumlah
bilangan kampung yang telah dikenalpasti di Semenanjung Malaysia dan Wilayah
Labuan yang mempunyai lokasi (spatial) adalah sebanyak 15,091 buah kampung.

Di dalam DPF Desa Negara 2030 juga, definisi desa adalah “selain kawasan
bandar yang mana penduduk kurang daripada-10,000 orang, bercirikan pertanian dan
kaya dengan sumber-alam semula jadi”. Di samping itu, kepadatan penduduk adalah
rendah dan asas ekonomi utama bagi penduduk berkaitan dengan pertanian, industri
desa dan sumber-asli. Desa akan -mengekalkan aktiviti sosial budaya desa termasuk
organisasi atau jawatankuasadesa, institusi kekeluargaan, aktiviti kemasyarakatan dan

kebudayaan.

Manakala di dalam Dasar Perbandaran Negara Kedua (DPN2) telah
mendefinisikan bandar sebagai “kawasan yang diwartakan serta kawasan tepu bina
yang bersempadan dengannya dan gabungan kedua-dua kawasan ini mempunyai
penduduk 10,000 orang atau lebih; atau kawasan pembangunan khusus atau pusat
pentadbiran daerah walaupun penduduk kurang daripada 10,000 orang dan sekurang-
kurangnya 60% penduduknya berumur 15 tahun dan ke atas terlibat dalam aktiviti

bukan pertanian.

Namun begitu, semakan data spatial yang diperoleh daripada Unit Dasar
Perancangan Fizikal Desa Negara, PLANMalaysia mendapati terdapat kawasan

petempatan tradisi (kampung) tetapi berada di dalam sempadan kawasan bandar. Hal



ini akan mungkin disebabkan oleh kesan daripada rebakan bandar atau lebih dikenali
sebagai “urban sprawl” yang mana berlakunya penyelerakan aktiviti guna tanah.
Rebakan bandar ini berlaku melangkaui sempadan bandar yang telah ditetapkan.
Menurut Karakayaci (2016), rebakan bandar adalah sebahagian daripada proses

pembandaran dan perkembangan bandar.

1.2 LATAR BELAKANG KAJIAN

Rebakan Bandar atau “urban sprawl” berlaku apabila sesebuah bandar itu tidak
mempunyai sempadan yang jelas. Hal ini telah menimbulkan beberapa isu seperti
penggunaan tanah secara tidak optimum, penyelerakan pembangunan guna tanah,
penukaran guna tanah kepada kegunaan perbandaran serta pengurangan kawasan hutan
dan pertanian. Selain itu, perkara ini juga akan menyebabkan kesukaran urus tadbir dan
penguatkuasaan yang berkesan dalm menentukan kawasan tampungan (catchment
area) untuk penyediaan kemudahan, infrastruktur dan utiliti kepada masyarakat

sekaligus meningkatkan kos akibat daripada pembangunan secara berselerak ini.

Menurut Anuar/Amir (1990), rebakan bandar yang berlaku telah mengakibatkan
sebahagian besar kawasan pinggir bandar yang dianggap zon peralihan (transition zon)
telah bertukar-kepada ciri-ciri bandar dan aspek fizikal dan juga bukan fizikal. Di
samping itu, rebakan bandar di-Malaysia telah menyebabkan pembangunan berpoket
(Anuar Amir, 1990). Hal ini telah memberi kesan kepada penduduk yang tinggal di
petempatan kampung kerana didapati banyak kampung-kampung seperti kampung
tradisi telah pupus dan lenyap, mengalami kadar penurunan penduduk, menjadi terasing
dalam perancangan pembangunan, hilang kriteria sebagai kawasan tempat tinggal atau
menghadapi isu-isu berkaitan alam sekitar. Isu ini dilihat menjadi lebih serius apabila
pembangunan kampung-kampung ini pinggir bandar dalam pelan-pelan pembangunan
tidak diberikan tumpuan yang sewajarnya dan terpisah daripada perancangan fizikal
bandar. Bagi memastikan rebakan bandar ini dapat dikawal maka Kajian Penentuan
Sempadan Bandar (PSB) telah diwujudkan.

Jurang pembangunan antara bandar dan desa dilihat amat ketara terutama dari
aspek penyediaan kemudahan awam, infrastruktur, utiliti dan peluang ekonomi. Desa

didapati kini mengalami tekanan pembangunan dari kawasan bandar sehingga



menjejaskan karektor dan imej desa itu sendiri (DPF Desa Negara 2030). Justeru, DPF
Desa Negara 2030 dirangka bagi memandu perancangan pembangunan desa di seluruh
Malaysia secara menyeluruh dalam menangani isu ketidakseimbangan pembangunan
antara bandar dan desa. Penentuan sempadan sesebuah kampung berdasarkan Sistem
Grid Desa Malaysia akan bertindak sebagai platform dalam menentukan kedudukan
spatial kampung dan mengurus maklumat fizikal desa dengan teratur. Hal ini
diterjemahkan dalam Kajian Penentuan Sempadan Kampung (PSK) yang dilaksanakan
bermula 2019 sehingga 2020.

Dengan ledakan informasi oleh Data Raya masa kini menjadi pendorong kepada
pertumbuhan inovasi baharu di samping membuka ruang kepada agensi Kerajaan untuk
melaksanakan Analitis Data Raya. Analitis Data Raya yang dilaksanakan ini dilihat
sebagai penggunaan Data Raya bagi tujuan analitis dalam menghasilkan visualisasi dan
aplikasi yang akan memberi faedah dan dapat dimanfatkan semasa membuat
perancangan dan keputusan. Penghasilan.visualisasi data yang baik telah menjadi satu
keperluan apabila berlakunya peningkatan jumlah (volume) dan kompleksiti data
(Yusuf, 2019). Hal ini kerana apabila bekerja-dengan data sama ada yang berstruktur
atau tidak berstruktur dalam-jumlah yang besar, visualisasi dilihat dapat membantu
menyokong kemampuan manusia untuk membuat kesimpulan persepsi dengan lebih
baik (Yusuf, 2019).

Salahsatu kaedah visualisasi yang sering digunakan dalam pelaksanaan Analitis
Data Raya adalah dengan pembangunan papan pemuka. Menurut Eigner (2013), papan
pemuka membolehkan seseorang itu membuat keputusan dalam tempoh masa yang
lebih singkat dengan maklumat yang tersedia. Hal ini kerana papan pemuka seringkali
dilihat sebagai alat bantu paparan visual data yang digunakan untuk memantau keadaan
atau memudahkan pemahaman dengan elemen infografik atau visualisasi naratif.
Sehubungan itu, bagi melihat kewujudan rebakan bandar terhadap persempadanan

kampung, pendekatan visualisasi secara papan pemuka dilaksanakan.

Salah satu perisian yang digunakan dalam melaksanakan visualisasi masa kini
adalah perisian Tableau. Tableau menggunakan inovasi integrasi seperti JavaScript

APIs dan aplikasi Single Sign-On untuk memasukkan analitik Tableau kepada aplikasi



bisnes yang asas secara konsisten. Tableau juga mampu mewujudkan pelbagai
visualisasi yang cukup untuk menyampaikan data secara interaktif. Selain itu, Tableau
membenarkan penyusunan data (data drilldown) dan melihat kesannya dalam format
visual yang memudahkan pemahaman individu. Tableau dilihat sebagai satu platform
analisis hujung-ke-hujung (end-to-end analysis) yang paling teguh, selamat dan
fleksibel berkaitan maklumat sehinggakan dirasakan mampu meningkatkan kuasa data
kepada pengguna (Nikhat Akhtar et. al. , 2020).

Model Cross Industry Standard Process for Data Mining atau CRISP-DM
biasanya digunakan bagi pelaksanaan projek perlombongan data (data mining) kerana
didapati dapat mengurangkan kos, mudah, boleh dipercayai, boleh diguna semula dan
pantas. Model CRISP-DM ini merangkumi enam fasa secara keseluruhannya iaitu fasa
pemahaman bisnes, fasa pemahaman data, fasa persediaan data, fasa pembangunan
model, fasa penilaian dan fasa pelaksanaan. Model CRISP-DM dilihat sebagai antara
model bisnes analitik yang sering digunakan secara meluas pada masa kini (Piatetsky,
2014).

13 PERNYATAAN MASALAH

Kajian PSB .telah diwujudkan bagi menentukan sempadan pertumbuhan bandar
mengikut kriteria yang ditetapkan dalam Garis Panduan Perancangan (GPP) Sempadan
Bandar. Penentuan sempadan bandar adalah bertujuan untuk menangani isu-isu rebakan
bandar yang tidak terkawal serta pengunaan tanah bandar yang tidak optimum sehingga

menyebabkan pembaziran sumber.

Selain pengurusan kawasan bandar yang mampan, kerajaan juga menjadikan
kawasan desa sebagai fokus perancangan utama negara kerana proses globalisasi yang
mengakibatkan desa-desa di pinggir bandar mengalami tekanan pembangunan yang
tinggi. PLANMalaysia telah menyediakan Kajian PSK Dan Penandaan Kedudukan
Spatial Kemudahan Awam Kampung telah dilaksanakan bermula 2019 sehingga 2020
berdasarkan DPF Desa Negara 2030 di bawah Teras 3: Pengukuhan Daya Huni Desa,
Dasar DD1 : Pemeliharaan Karektor Spatial Desa dan Strategi DD1.1 : Menentukan

Sempadan Kampung. Manakala bagi projek penandaan lokasi spatial kemudahan awam



adalah di bawah Dasar DD4 : Penyediaan Kemudahan Awam, Strategi DDA4.1:

Menyediakan Kemudahan Awam yang Mencukupi dan Berkualiti.

Kajian PSK bertujuan untuk mewujudkan satu perancangan dan penyelarasan
penyediaan kemudahan awam kampung yang lebih efisyen. Kajian PSK adalah penting
dalam memastikan maklumat sempadan kampung dan kedudukan spatial kemudahan
awam kampung tersedia bagi penyelarasan isu-isu di peringkat kampung seperti
peruntukan, pentadbiran, pewartaan sempadan kampung, pengekalan kawasan rizab,
pengurusan bencana dengan lebih mudah.

Kajian PSB dan PSK ini telah menentukan sempadan bandar dan sempadan
kampung yang dapat dijadikan sempadan rasmi yang seragam untuk diguna pakai oleh
pelbagai agensi berkepentingan dalam ‘membuat perancangan dan pembangunan
terutamanya penyediaan kemudahan awam untuk manfaat penduduk. Namun begitu,
Kajian PSB hanya terhad kepada penyediaan penentuan sempadan bandar dan profil
bandar manakala Kajian PSK pula melibatkan penentuan sempadan kampung,
penandaan kedudukan spatial kemudahan awam kampung, profil kampung dan potensi
kampung. Bagaimana pula dengan kampung yang berada di dalam kawasan bandar?
Adakah penempatan tradisi di dalam sempadan kawasan bandar boleh dianggap sebagai
kampung? Jika ya, ini akan menimbulkan kekeliruan kerana dilihat kontradik dengan
penakrifan kampung yang telah didefinisikan di dalam Dasar Perancangan Fizikal Desa
Negara 2030 yang mana menyatakan kampung adalah sebuah petempatan tradisi di
kawasan desa. Atau sememangnya tidak wujud kawasan penempatan tradisi di dalam

sempadan kawasan bandar di Malaysia?

Selain itu, daripada perbincangan bersama FGD mendapati untuk membuat
satu-satu analisis berkaitan perancangan perbandaran dan persempadanan akan
mengambil tempoh yang agak lama terutama apabila terdapat Dasar Baharu Kerajaan
diperkenalkan. Hal ini kerana data-data sedia ada mempunyai format-format yang
berbeza dan perlu dimurnikan serta diproses terlebih dahulu sebelum dapat
diterjemahkan dalam bentuk visual. Tambahan pula, tiada lagi satu platform yang boleh
dijadikan sebagai ‘papan pemuka strategik’ bagi agensi untuk digunakan dalam

membantu membuat keputusan bagi pelaksanaan dasar-dasar Kerajaan.



1.4 OBJEKTIF KAJIAN

Objektif kajian ini adalah seperti berikut:

a. Menghasilkan visualisasi sempadan kampung dalam bandar dalam bentuk
papan pemuka bagi membantu membuat keputusan menggunakan Tableau.

b. Menilai keberkesanan visualisasi sempadan kampung dalam bandar dalam
bentuk papan pemuka berdasarkan dapatan dari perbincangan kumpulan fokus
(Focus Group Discussion, FGD).

15 SKOP KAJIAN

Skop kajian ini melibatkan data-data persempadanan, bilangan bandar dan kampung
serta populasi penduduk di Negeri Sembilan dan Melaka. Data-data mentah yang
terlibat di dalam kajian ini adalah dalam pelbagai format seperti .xIs, .xlsx, .csv dan .shp.
Data-data ini diterima daripada Bahagian Rancangan Fizikal Negara, PLANMalaysia
yang telah dikumpulkan daripada Pejabat-Projek Zon Selatan, PLANMalaysia Negeri

dan Pihak Berkuasa Tempatan Negeri Sembilan dan Melaka.

Seterusnya, skop ini kajian akan melibatkan reka bentuk pembangunan papan
pemuka yang akan memplotkan sempadan-sempadan bandar dan kampung di Negeri
Sembilan dan Melaka. Dengan itu, pembangunan papan pemuka ini juga akan dapat
mengenalpasti dan memplotkan sempadan kampung yang berada di dalam sempadan
bandar bagi dua negeri yang tersebut. Selain itu, pembangunan papan pemuka ini turut
dapat memaparkan statistik bilangan bandar, kampung, kampung dalam bandar dan
penduduk. Pembangunan papan pemuka ini akan menggunakan perisian Tableau bagi
paparan yang dikehendaki. Skop kajian ini hanya melibatkan dua negeri sahaja kerana
data-data yang terlibat telah tersedia dan kajian ini akan menjadi rintis kepada negeri-

negeri lain di Malaysia.

1.6 SUSUN ATUR BAB

Laporan projek ini secara keseluruhannya terbahagi kepada lima bahagian.

Bab I :membincangkan berkenaan pengenalan, pernyataan masalah, objektif kajian,

persoalan kajian dan skop kajian.



Bab Il : menerangkan kajian kepustakaan mengenai perancangan fizikal negara, kajian
persempadanan yang telah dilaksanakan, perisian Tableau dan kajian pembangunan

papan pemuka menggunakan pendekatan perisian Tableau.

Bab 11l : membincangkan mengenai kaedah kajian yang akan digunakan terdiri
sepanjang kajian dilaksanakan melibatkan daripada proses kerja kajian sehinggalah

pembangunan papan pemuka.

Bab IV : membincangkan berkaitan hasil pembangunan papanpemuka dan analisis data
yang diperolehi.

Bab V: merujuk kepada kesimpulan keseluruhan kajian, perbincangan dan cadangan

penambahbaikan kajian ini pada masa hadapan.

1.7 RUMUSAN

Kajian ini dilaksanakan menggunakan data-data sedia ada yang digunakan oleh agensi
dalam membuat perancangan pembangunan-fizikal melibatkan kawasan bandar dan
kampung di sesebuah negeri.-Matlamat_kajian-adalah hasil kajian yang dilaksanakan
dapat membantu agensi terutama pihak pengurusan dalam membuat keputusan yang
lebih tepat berdasarkan keperluan dasar dan pembangunan sedia ada. Di samping itu,
dapat memudahkan pelaksana membuat analisis data yang pada masa kini memerlukan

proses kerja'yang lebih panjang.



BAB Il

KAJIAN SUSASTERA

2.1 PENGENALAN

Bab 11 membincangkan berkenaan dengan rebakan bandar yang berlaku serta kajian-
kajian berkaitan yang dilaksanakan bagi menangani isu rebakan bandar yang berlaku.
Di samping itu, bab ini juga akan membincangkan peranan visualisasi data serta sub
bidang visualisasi data yang ada pada masa Kini. Seterusnya, di dalam bab ini juga akan
melihat kajian-kajian berkaitan visualisasi yang dilaksanakan menggunakan perisian

Tableau.

2.2 KAJIAN PENENTUAN SEMPADAN.SEDIA ADA

Merujuk kepada Teras 1 di dalam Dasar Rancangan Fizikal Negara Ke-3 menyatakan
Pertumbuhan/Dinamik-Bandar dan‘Luar Bandar adalah penting dalam mencapai status
negara maju dan berpendapatan tinggi. Teras ini dilihat dapat memperkukuh peranan
bandar sebagai pemangkin utama seterusnya membantu bagi mempertingkat keupayaan
dan‘daya saing kawasan luar bandar dalam pembangunan ekonomi negara. Bandar
merupakan nadi pembangunan negara kerana mempunyai populasi penduduk yang
tinggi serta menjadi pusat tumpuan kegiatan ekonomi. Oleh itu, penekanan diberikan
kepada kawasan bandar bagi merangsang pertumbuhan ekonomi bandar yang baik.
Manakala di kawasan luar bandar, penumpuan diberikan kepada penyediaan
infrastruktur dan utiliti termasuk jalan, air, elektrik, kemudahan pendidikan dan
kesihatan serta kemudahan sosial bagi mempertingkat kualiti hidup penduduk dan
prestasi ekonomi luar bandar. Strategi pembangunan bagi kedua-dua kawasan ini adalah
bertujuan bagi memastikan keseimbangan pertumbuhan ekonomi dan merapatkan

jurang pembangunan bandar dan luar bandar.
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Rentetan daripada itu, Dasar Perbandaran Negara Kedua (DPN2) dirangka bagi
memastikan pembangunan bandar dapat dirancang dengan harmoni manakala Dasar
Perancangan Fizikal Desa Negara pula disediakan sebagai perancangan holistik
pembangunan luar bandar. Kedua-dua dasar ini menjadi sumber rujukan dalam
perancangan pembangunan dalam ruang lingkup sempadan masing-masing. Namun,
menurut Karakayaci (2016), tren rebakan bandar masih berlanjutan di Malaysia
terutama di kawasan Metropolitan. Isu rebakan bandar ini telah memberi kesan kepada
corak pembangunan kawasan sekitarnya hingga mengancam kelestariannya (Yasin et.
al, 2020).

Antara punca yang dikenalpasti menyebabkan rebakan bandar ini masih berlaku
adalah kerana kurangnya penyelarasan antara agensi yang berkaitan serta kurangnya
pemantaun bagi pelaksanaan polisi yang telah digariskan (Naeema, 2016). Kenyataan
ini dikukuhkan apabila didapati Penentuan® Had Sempadan Bandar telah pun
dikenalpasti dan digariskan di dalam Dasar Perbandaran Negara Kedua (DPN2) yang
merangkumi Sempadan Pertumbuhan Bandar (Urban Growth Boundary, UGB) dan
Sempadan Pembendungan Bandar (Urban Centainment Boundary, UCB) yang mana
dibangunkan bagi menangani-isu rebakan bandar di Malaysia sekaligus mengelakkan

pembaziran sumber.

Agensi terlibat juga telah melaksanakan Kajian PSB dan Kajian PSK yang
menentukan sempadan bandar dan sempadan kampung yang dapat dijadikan sempadan
rasmi yang seragam untuk diguna pakai oleh pelbagai agensi berkepentingan dalam
membuat perancangan dan pembangunan. Daripada kajian yang dilaksanakan, data dan
maklumat berkaitan disimpan di dalam gudang data masing-masing kerana dua kajian
tersebut dilaksanakan oleh dua entiti unit yang berbeza. Hal ini menyebabkan kesukaran
berlaku apabila persempadanan bagi kampung dalam bandar ingin dipaparkan dalam
satu paparan papan pemuka. Sehubungan itu, data-data daripada kedua-dua kajian ini
perlu dintegrasikan. Kaedah visualisasi data dilihat boleh digunakan untuk memaparkan

maklumat berkaitan bandar, kampung mahupun kampung dalam bandar.
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2.3 VISUALISASI DATA

Visualisasi dan interpretasi data telah menjadi satu daripada kemahiran penting pada
masa kini. Sememangnya tidak dapat dinafikan visualisasi data dan penggunaan papan
pemuka membolehkan eksekutif membuat keputusan dalam masa yang singkat dengan
maklumat yang diperlukan (Eigner, 2013). Inilah bahagian yang kritikal dalam evolusi
bagi ‘business intelligence’ dikenali sebagai analitik bisnes (Negash, 2004). Visualisasi
data membawa maksud mengatur maklumat mengikut lokasi spatial dan menyokong

kesimpulan persepsi.

Visualisasi data adalah penggunaan kemahiran semula jadi manusia untuk
meningkatkan pemprosesan data dan kecekapan.organisasi. Visualisasi data juga adalah
perwakilan kepada data atau informasi sama ada dalam bentuk graf, carta atau lain-lain
format visual. Visualisasi dapat membantu menangani maklumat yang lebih kompleks

serta meningkatkan daya ingatan.(Matthew et al., 2016).

Selain itu, visualisasi data menghubungkan antara data dengan imej dan ini
adalah penting kerana ia menjadikan sesuatu trend atau corak lebih mudah dilihat
seterusnya difahami. Dengan perkembangan data raya pada masa ini, telah menjadi satu
keperluan bagiseseorang itu mampu mentafsir Kumpulan data yang semakin membesar.
Pembelajaran mesin (machine learning) menjadikannya lebih mudah untuk melakukan
analisis seperti. analisis ramalan, yang kemudian dapat berfungsi sebagai visualisasi

yang berguna untuk dipersembahkan (Min Chen et al. , 2009).

Namun begitu, visualisasi data tidak hanya penting kepada Saintis Data dan
Juruanalisis Data sahaja kerana pada masa kini ia telah menjadi satu tuntutan bagi
memahami visualisasi data dalam apa jua kerjaya yang diceburi. Tidak kira bidang
kerjaya apa pun, telah menjadi satu keperluan untuk data diterjemahkan dalam bentuk
visual. Hal ini menunjukkan betapa pentingya data visualisasi. Tujuan utama visualisasi
data adalah untuk menyaring dataset besar ke dalam grafik visual untuk memudahkan
pemahaman hubungan kompleks dalam data (Firoj, P. et. al, 2018). Di samping itu,
visualisasi data juga sering diterjemahkan dengan istilah seperti grafik maklumat, grafik
statistik, dan visualisasi maklumat. Visualisasi data boleh dilihat sebagai satu bidang

yang luas dengan banyak disiplin ilmu.



12

2.4 SUB BIDANG VISUALISASI DATA

Secara umumnya, visualisasi data adalah penyampaian maklumat kuantitatif dalam
bentuk grafik. Dalam erti kata lain, visualisasi data mengubah dataset tidak Kkira yang
besar ataupun kecil ke dalam bentuk visual yang memudahkan proses pemahaman
manusia. Jika diteliti, visualisasi data bukanlah satu yang asing dalam kehidupan
seharian manusia kerana visualisasi data ini sering muncul dalam bentuk carta dan graf
(Michael F., 2007). Dalam konteks kepintaran bisnes pula, visualisasi data membantu
pengguna dalam membuat keputusan yang lebih baik. Visualisasi data mengubah data
mentah kepada maklumat yang difahami. Terdapat tiga sub bidang data visualisasi yang
signifikan.

2.4.1 Visualisasi Saintifik

Visualisasi data saintifik adalah perwakilan data secara grafik untuk mendapatkan
pemahaman mengenai data. Hal ini membolehkan pengkaji mendapat gambaran kepada
sistem yang mengkaji maklumat yang sebelum..ini mustahil untuk dilaksanakan.
Visualisasi data boleh dirujuk sebagai analisis-visualisasi‘data (Rui Li dan Jian Chen,
2018). Tujuannyaadalah -untuk menyampaikan data saintifik dengan tepat,
mendedahkan struktur dasar di dalam data .dan” menggalakkan penerokaan data.
Visualisasi saintifik dilihat sebagai ‘interdisciplinary research’ dan bidang aplikasi
dalam sains, memberi fokus kepada fenomena visualisasi tiga dimensi seperti seni bina,
meteorologi, perubatan atau sistem biologi dengan matlamat untuk menggambarkan
data saitifik secara grafik yang membolehkan para saintis memahami, menjelaskan

malah mengumpul corak daripada data

2.4.2 Analitik Visual

Analitik visual boleh dianggap sebagai pendekatan bersepadu yang menggabungkan
visualisasi, faktor manusia dan analisis data. Analitik visual merupakan bidang baharu
yang telah berkembang daripada pembangunan visualisasi saintifik dan visualisasi
maklumat dengan penekanan kepada penaakulan analitik melalui antara muka visual
yang interaktif. Kaedah analitik visual membenarkan pembuat keputusan untuk
menggabungkan fleksibiliti, kreativiti dan pengetahuan mereka dengan kapasiti storan

dan pemprosesan komputer masa kini yang sangat besar bagi mendapatkan gambaran



13

kepada isu-isu yang kompleks (Thomas J dan Cook K, 2005). Dalam konteks
visualisasi, analitik visual dilihat berkait rapat dengan visualisasi maklumat dan grafik
komputer. Manakala bagi analisis data, analitik visual ini banyak memanfaatkan
bermula daripada kaedah memperolen maklumat, perwakilan pengurusan data dan

pengetahuan termasuklah perlombongan data.

2.4.3 Visualisasi Maklumat

Visualisasi maklumat pula dirujuk sebagai penggunaan perwakilan visual interaktif
yang disokong oleh komputer bagi set data abstrak berangka dan bukan berangka untuk
meningkatkan kognisi manusia. Visualisasi maklumat. adalah satu bentuk seni
menyampaikan data dalam bentuk yang mudah-difahami dan dimanipulasi sekaligus
dapat membantu memahami maklumat dan‘menjadikannya berguna dalam kehidupan
(Daniel Keim, 2002). Visualisasi maklumat juga merupakan komunikasi data abstrak
melalui antara muka visual yang.interaktif. Grafik seperti histogram, graf tren, carta
alir, rajah pokok adalah contoh visualisasi maklumat dan rekabentuk grafik ini
mengubah konsep yang abstrak kepada maklumat visual.

Pada masa Kini, apa yang berlaku di agensi didapati visualisasi sedia ada hanya
dapat memaparkan sempadan bandar dan sempadan kampung sahaja. Tambahan pula,
kedua-dua. visualisasi ini hanya dapat diakses secara berasingan. Keadaan ini
menyukarkan pihak pengurusan untuk mengenalpasti keberadaan sempadan kampung
dalam bandar di sesebuah negeri. Di samping itu, tiada lagi visualisasi yang
dibangunkan agensi yang menggabungkan statistik dan pemetaan bandar dan luar
bandar bagi sesebuah negeri. Sehubungan itu, visualisasi yang menggabungkan kedua-
dua elemen dan kawasan ini amat diperlukan agar dapat membantu agensi membuat

keputusan yang tepat dan cepat.

25 KAJIAN BERKAITAN PERISIAN TABLEAU

Antara alat bantu yang semakin diperkatakan dan menjadi pilihan ramai dalam
pelaksanaan visualisasi data adalah perisian Tableau. Tableau merupakan salah satu
perisian visualisasi yang mampu membantu pengguna meneroka dan memahami data

dengan menghasilkan visualisasi yang interaktif (Nikhat Akhtar et. al. , 2020). Tableau
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ini juga digunakan sebagai alat dalam melaksanakan analisis data yang boleh
dihubungkan dengan pelbagai sumber data di samping fungsinya yang memungkinkan
penggabungan data (data blending) dan pelaporan masa nyata (real-time). Selain itu,
Tableau mampu menggunakan set data yang besar untuk dianalisis, divisual dan
dikongsi bersama (Ahmed, M. A. et. al. 2019). Hal ini membuatkan Tableau sebagai
satu perisian yang sering menjadi pilihan ramai di samping kemampuannya untuk

menterjemahkan data kepada papan pemuka visual yang bermatlamat (Ben J., 2014)

Terdapat pelbagai kajian yang menggunakan™ perisian Tableau bagi
menghasilkan visualisasi data. Antaranya adalah Pembangunan Dashboard Bagi Lokasi
Tanah Longsor Di Indonesia (Ridho Darman, 2018), Tableau : Alat Visualisasi Data
Raya dalam Institut Pengajian Tinggi bagi Matlamat Pembangunan Lestari (Ahmed, M.
A. et. al. 2019), Analitik Data dan Visualisasi Menggunakan Tableau bagi COVID-19
(Coronavirus) (Nikhat Akhtar et. al. , 2020).

Ridho Darman (2018) membuat kajian berkenaan bencana alam tanah runtuh
yang sering berlaku di Indonesia. Dengan menggunakan data tanah runtuh yang terjadi
di Indonesia daripada Tahun 2011 hingga 2014, Ridho Darman (2018) telah
menghasilkan papan‘pemuka bagi mengenalpasti-kawasan-kawasan tanah runtuh di
seluruh Indonesia'yang merangkumi data statistik dan juga peta grafik. Daripada kajian
yang dijalankan‘dapat dikenalpasti bahawa daerah Jawa Barat merupakan daerah paling
terdedah kepada berlakunya tanah runtuh dan punca utama berlakunya tanah runtuh
adalah disebabkan hujan lebat yang berterusan. Perisian Tableau yang digunakan di
dalam kajian ini didapati sangat membantu dalam mendapatkan maklumat daerah
paling terdedah terhadap ancaman tanah runtuh. Dengan ini diharapkan orang awam
dan pihak Pemerintah Indonesia dapat merancang kesiapsiagaan dalam menghadapi
kejadian tanah runtuh di samping membantu merancang hala tuju guna tanah kawasan

terbabit yang sesuai dengan keadaan muka buminya. (Ridho Darman, 2018).

Ahmed, M. A. et. al. (2019) pula membuat kajian berkaitan penggunaan Tableau
di Institut Pengajian Tinggi untuk mencapai Matlamat Pembangunan Lestari (SDGs) di
Mesir. Dengan menggunakan Tableau, pengkaji mencadangkan bahawa 17 SDGs boleh

dianalisis, divisualisasikan dan dikongsi. Hal ini kerana Tableau menyediakan pelbagai
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bentuk kemudahan graf, carta dan papan pemuka yang boleh membantu dalam
mendapatkan alatan yang lebih baik dalam usaha Institut Pengajian Tinggi memelihara
kelestarian yang berkaitan. Tableau dilihat sebagai satu alat untuk menilai tahap yang
boleh dicapai oleh Institut Pengajian Tinggi dalam menyumbang ke arah pencapaian
kelestarian pembangunan dalam sempadan geografi pendidikan dalaman dan luaran
(Ahmed, M. A. et. al., 2019).

Bagi Nikhat Akhtar et. al. (2020), penggunaan Tableau dicadangkan bagi
menvisualisasikan maklumat berkaitan wabak COVID-19 yang melanda dunia kini
untuk mendapatkan gambaran yang jelas serta impak wabak tersebut. Hal ini kerana
Nikhat Akhtar et. al. (2020) percaya Tableau boleh - memainkan peranan yang penting
dalam menvisualkan set data yang besar berkaitan data-data wabak dengan
pembangunan papan pemuka di samping melaksanakan analisis ramalan untuk
dijadikan panduan dalam mencari solusi kepada wabak yang melanda. Orang awam,
para saintis dan pengkaji boleh segera mendapat akses kepada maklumat yang boleh
dipercayai bahkan juga membolehkan mereka menbuat analisis yang berkaitan untuk
diri mereka sendiri. Selain itu, Tableau juga dilihat menyediakan satu bentuk ruang dan
peluang dalam menemukan corak data COVID-19 seperti tingkah laku pandemik
COVID-19, sepadan dengan hasil yang diperoleh melalui algoritma pembelajaran
mesin dan visualisasi Tableau (Nikhat Akhtar et. al. 2020).

Dapat dilihat di sini bagaimana Tableau telah menjadi pilihan terkini dalam
visualisasi data. Faktor utama Tableau semakin menjadi pilihan pengguna adalah
disebabkan oleh Tableau bukan sahaja mudah untuk digunakan tetapi dapat
menghasilkan visualisasi yang sangat baik. Tambahan pula, kemudahan ‘drag and
drop’ yang terdapat di dalam Tableau ini sangat memberi keselesaan kepada pengguna.
Menurut Gartner’s Magic Quadrant, lebih 70% pengguna Tableau memilih
menggunakannya adalah disebabkan ia mudah digunakan dan asas Tableau dapat

difahami dalam masa beberapa jam sahaja.

Di samping itu, ketiga-tiga pengkaji ini bersependapat bahawa penggunaan
Tableau dapat mereka bentuk papan pemuka dengan cepat, mudah dan tepat. Hal ini

disebabkan oleh Tableau boleh dihubungkan adalah sumber data yang pelbagai serta
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mampu menampung set data yang besar dalam pelaksanaan proses reka bentuk yang

diperlukan.

2.6 RUMUSAN

Secara kesimpulannya, dapat dilihat visualisasi data memberikan interpretasi dan
gambaran yang jelas terhadap data-data dengan sepenuhnya. la mampu membantu
agensi dalam membuat keputusan yang cepat dan tepat dalam menangani isu rebakan
bandar yang memberikan impak yang besar kepada kawasan kampung terutama sekali
bagi kawasan kampung dalam bandar. Hal ini kerana dengan-adanya visualisasi ini, ia
bukan sahaja membuktikan kewujudan kampung dalam bandar secara pemetaan tetapi
ia juga dapat membantu perancangan pembangunan dan.penyediaan kemudahan yang

sewajarnya diberikan kepada penduduk kampung tersebut.

Tidak dapat dinafikan_juga, visualisasi data yang baik perlu mempunyai
gabungan sumber data seperti gabungan data dan imej supaya visual yang dihasilkan
adalah lebih memberi makna dan mudah difahami. Penyampaian menggunakan visual
akan lebih mudah menarik perhatian berbanding paparan nombor dan abjad sahaja. Hal

ini sangat berkait rapat dengan daya pemikiran dan kemahiran semula jadi manusia.

Penggunaan perisian Tableau telah menjadi suatu yang tidak asing lagi sebagai
salah satu alat yang digunakan dalam usaha menvisualisasikan data-data yang pada
masa kini begitu besar dan pelbagai. Kelebihan dan kemudahan yang ada perisian
Tableau ini menjadikannya pilihan utama dalam merealisasikan visualisasi data yang
bukan sahaja dapat memberi impak kepada orang awam tetapi juga kepada pembuat
keputusan. Salah satu pendekatan yang digunakan adalah dengan pembangunan papan
pemuka yang mana dikatakan dapat memberi gambaran yang lebih jelas di dalam satu
paparan sahaja tetapi maklumat yang disampaikan dapat difahami dengan mudah.
Sehubungan itu, kajian ini akan menggunakan perisian Tableau dengan pendekatan
pembangunan papan pemuka bagi menentukan kedudukan kawasan kampung dalam
bandar.



BAB IlI

KAEDAH KAJIAN

3.1 PENGENALAN

Bab Il membincangkan secara terperinci pendekatan atau kaedah yang digunakan
dalam pelaksanaan kajian ini. Penerangan meliputi keseluruhan peringkat proses kerja
yang disusun bermula daripada kajian dan analisis awal yang mana akan mengenalpasti
isu dan permasalahan persempadanan bandar dan kampung. Seterusnya, kaedah
pengumpulan data yang merangkumi data primer yang melibatkan temubual dengan
kumpulan fokus (FGD) dan data sekunder seperti kertas laporan persempadanan
kampung akan diterangkan. Kemudian, data-data yang dikumpul tersebut akan
dianalisis mengikut format yang diperlukan..Akhir sekali, data-data tersebut akan
diterjemahkan dalam-pembangunan papan pemuka menggunakan perisian Tableau.

3.2 REKA BENTUK KAJIAN

Dalam reka bentuk kajian ini, pendekatan yang digunakan adalah berasaskan kepada
Model Cross Industry Standard Process for Data Mining atau CRISP-DM. Rajah 3.1
menunjukkan bagaimana setiap fasa yang terlibat, ia juga menunjukkan bagaimana
setiap fasa memberi kesan kepada fasa yang seterusnya dalam satu kitaran. Dengan itu,
ini akan membolehkan pengenalpastian semula bagi fasa sebelumnya sekiranya

terdapat keperluan untuk pengulangan tindakan (Piatetsky, 2014).
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Rajah 3.1 : Enam fasa CRISP-DM

Di samping itu, Model CRISP-DM membolehkan pergerakan bebas antara
kitaran fasa dalam pelaksanaan projek. Lingkaran .anak panah di sebelah luar
menggambarkan sifat perlombongan data itu sendiri di mana memerlukan proses yang

berterusan sekalipun pengetahuan/petua/hasil telah diperolehi.

3.2.1 Fasal: Pemahaman Bisnes

Dalam fasa 1 ini, objektif dan keperluan projek akan dibincangkan dan difahamkan.
Seterusnya objektif dan keperluan projek akan menjadi asas kepada perancangan awal
projek. Perkara ini penting kerana fasa seterusnya serta hasil projek perlu selari dengan
fasa pertama ini. Fasa 1 ini juga akan mengenalpasti analisis yang akan dilaksanakan,
mereka bentuk model bisnes sekiranya perlu, menggariskan jangkaan analisis dan
keputusan yang dikehendaki, menentukan kepintaran bisnes yang akan digunakan di

dalam projek dan mengenalpasti sumber bagi proses pengumpulan data.

3.2.2 Fasa 2 : Pemahaman Data

Fasa 2 akan dimulakan dengan pengumpulan data selaras dengan objektif dan keperluan
projek, melakukan kajian terhadap data berkenaan bagi tujuan untuk memahaminya,
mengenalpasti kewujudan masalah dan isu pada data, mencari dan menemukan
pengertian melalui data berkenaan berdasarkan maklumat tersembunyi daripada data

tersebut. Hal ini termasuklah keperluan untuk merekodkan sumber dan isu semasa
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mendapatkan data supaya dapat dilihat semula sekiranya perlu nanti. Fasa ini juga akan
melibatkan pengenalpastian kualiti data daripada data yang telah dikumpulkan dari
pelbagai sumber dengan objektif projek sebagai panduan untuk memahami data
tersebut. Justeru, ini akan membolehkan dua fasa awal ini diulang semula bagi

memperoleh pemahanan data yang lebih baik.

3.2.3 Fasa 3 : Persediaan Data

Persediaan Data dalam fasa 3 ini melibatkan tiga langkah iaitu pemilihan, pra-
pemprosesan dan transformasi data. Langkah pertama yang dilakukan adalah memilih
data untuk dianalisis dengan melihat kepada keseragaman, kebolehlaksanaan dan
konsistensi data. Kemudian, pada langkah keduasiaitu pra<pemprosesan, data diperiksa
berdasarkan kesesuaian data tersebut untuk disertakan atau dikecualikan daripada data
utama yang akan dianalisis. Ini dipanggil pembersihan atau pemurnian data. Setelah itu,
data yang telah dibersihkan akan.dimasukkan ke dalam pangkalan data. Di dalam fasa
ini perisian Rapidminer digunakan bagi melaksanakan integrasi data yang terlibat untuk
digunakan semasa pembangunan.papan pemuka.

3.2.4 Fasa 4 : Pemodelan

Fasa Pemodelan.ini:meliputi kepada pemilihan teknik pemodelan setelah melihat setiap
parameter terlibat, menghasilkan templat reka bentuk, membina model, dan menilai
model. Dalam fasa ini perisian Tableau akan digunakan bagi pelaksanaan pemodelan
dan visualisasi. Antara kelebihan penggunaan perisian Tableau bagi pemodelan data
adalah kemampuan untuk mengendalikan set data yang besar dan penyatuan yang lebih
mudabh. Selain itu, Tableau dilihat boleh melaksanakan pelbagai tugas dan menjadikan
prosesnya mudah dan tepat untuk seterusnya iaitu fasa penilaian data di mana ia boleh
menyambung, menyatukan, menyiapkan, dan menyusun data mengikut keperluan

kajian.

3.25 Fasab : Penilaian

Fasa seterusnya adalah fasa penilaian yang mana akan melibatkan penilaian hasil,
mengkaji proses, dan menentukan langkah-langkah berikutnya. Hasilnya dinilai selepas

pemodelan untuk memeriksa sejauh mana model atau visualisasi sesuai dengan objektif
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kajian. Aktiviti yang terlibat adalah melihat dan menilai hasil, membandingkan hasil,

menafsirkan corak atau paten bagi menentukan kesahan, menjadikannya mudah

difahami serta menarik. Hal ini akan sangat berguna untuk membantu mewujudkan

satu kedudukan (ranking) hasil yang diperoleh dari segi kriteria kejayaan kajian, kesan

pada objektif kajian dan membolehkan kajian lanjut dilaksanakan

3.2.6

Fasa 6 : Penggunaan Model

Akhir sekali adalah merupakan Fasa Penggunaan Model di mana data diterjemah ke

dalam praktikaliti dan boleh digunakan bagi mencapai objektif dan keperluan kajian.

3.3 PROSES KERJA KAJIAN

Berdasarkan kepada Model CRISP-DM, proses Kerja kajian ditunjukkan seperti dalam

Rajah 3.
Model

CRISP DM

Proses
Kerja

2

—

ST T AN

Fasa 5 & Fasa 6 >

Proses Kerja 1:
Perbineangan
bersama FGD.,
pembacaan dan
analisis jurnal,
artikel, buku dan
tesis.

Tujuan:
Mengenalpasti
penyataan
masalah. objektif
kajian, skop Kajian

Proses Kerja 2:
Perolehan data,
pemahiaman
data,
pembersihan
data dan
integrasi data.

Tujuan:
Mengenalpasti
data-data terlibat
dalam kajian,

Proses Kerja3:
Mereka bentuk
paparan papan
pemuka.

Tujuan:
Memaparkan
persempadanan
bandar , kampung
dan kampung
dalam bandar.

Proses Kerja 4:
Penilaian FGD

Tujuan:
Mengesahkan
persempadanan
kampung dalam
bandar yang
dibangunkan.

<

4

==
Output: Output:
* Penyataan Data bersih
masalah vang akan
o Objektif digunakan
kajian dalam Kajian.

* Skop kajian

Output:

Papan pemuka
bagi
persempadanan
bandar, kampung
dan kampung
dalam handar

Output:
Sempadan
kampung dalam
bandar
digunapakai.

Rajah 3.2 : Proses Kerja Kajian
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3.3.1 Proses Kerja 1 : Pemahaman Kajian.

Proses Kerja Pertama terdiri daripada Fasa 1 Model CRISP-DM yang merupakan
perbincangan bersama kumpulan fokus (FGD) dalam memahami situasi semasa yang
dihadapi. Kemudian, kajian susastera dijalankan bagi pengumpulan maklumat kajian-
kajian lepas melalui pelbagai bahan bacaan seperti jurnal, artikel, laporan teknikal, buku
dan tesis. Ini bertujuan untuk mengenal pasti penyataan masalah, objektif kajian,

persoalan kajian dan skop kajian.

3.3.2 Proses Kerja 2 : Pemahaman Data.

Proses Kerja Kedua pula terdiri daripada Fasa 2 dan Fasa 3 Model CRISP-DM iaitu
proses pemahaman data yang terdiri daripada beberapa aktiviti iaitu perolehan data,
mengenalpasti isu data, eksplorasi data dan seterusnya memahami data berkenaan. Data
tersebut seterusnya disediakan dalam proses persediaan data yang bermatlamat bagi
menghasilkan set data muktamad. Aktiviti-aktiviti dalam proses ini adalah pemilihan

data yang bersesuaian, pembersihan data, menjana data dan integrasi set data-set data.

3.3.3 Proses Kerja.2.: Pembersihan Data.

Data yang diperoleh ‘daripada daripada Bahagian Rancangan Fizikal Negara,
PLANMalaysia merupakan data mentah yang akan digunakan di dalam kajian terdiri
daripada pelbagai format. Bagi data-data yang melibatkan bilangan bandar, kampung
dan populast penduduk adalah dalam format .xls , xIsx dan .csv. Namun, dalam kajian
ini, data-data tersebut akan ditukar kepada satu format sahaja iaitu di dalam format .csv.
Justeru, bagi data-data tersebut, perisian Microsoft Excel telah digunakan bagi tujuan

tersebut. Rajah 3.3 menunjukkan contoh data dalam format .xls yang diperoleh.

Rajah 3.3 : Data dalam format .xIs
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Kemudian, data ini akan disimpan dalam format .csv seperti yang ditunjukkan dalam
Rajah 3.4.

4 |« UKM » Master Project » v O

Organize » Mew folder - (7]
Master_Project A Mame ’ Status Date mod
Master_Project Gaya UKM I°)

NEMAS Jurnal&Thesis @

) Microso ft Excel Q') Data Kampung.csv
@ OneDrive

&] Synology Drive - PLAN Malaysia

3 This PC
v < >

File name: | Data Kampung.csv -
Save as type: | CSV (Comma delimited) (*.cov) bl

ors:  ACER Tags"(Add » tag

~ Hide Folders ook = | Shve h Cancel

Rajah 3.4 : Data disimpan dalam format .csv

Di samping itu juga, data-data-sempadan bandar dan kampung yang diterima pula
adalah dalam format .shp seperti-Jadual 3.1

Bil. Data Keterangan

1. sempadan_bandar.shp Lokasi Bandar bagi Melaka dan
Negeri Sembilan

2. sempadan_Kampung_Negeri_Sembilan. shp Lokasi Kampung di Negeri
Sembilan

3. sempadan_Kampung_Melaka. shp Lokasi Kampung di Melaka

Jadual 3.1 : Format Asal Data Persempadanan

Walaupun data format .shp ini digunakan sebagai visual pemetaan, terdapat keperluan
di mana data-data .shp ini perlu digabungkan dalam satu diubah format shapefiles dan
juga diproses kepada format .csv untuk memudahkan penggunannya semasa
pembangunan Tableau dan Rapidminer. Bagi mengubah format data-data sempadan ini,
perisian QGIS digunakan. Perisian QGIS ini adalah perisian open-source yang
menyokong bagi paparan dan suntingan melibatkan data-data spatial. Tiga proses data
spatial yang terlibat iaitu proses menggabungkan dan mengeksport maklumat kampung
bagi dua negeri yang dikaji, proses memurnikan dan mengeksport maklumat bandar dan

proses mengenalpasti intersection antara kampung dan bandar.
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a. Proses Gabung dan Eksport Maklumat Kampung di Negeri Sembilan dan
Melaka.

Proses pertama ini dilakukan bagi mendapatkan maklumat pemetaan berkaitan dua
negeri di dalam kajian dalam satu layer dengan format .shp dan juga format .csv.

Terdapat lima langkah yang dilakukan bagi proses pertama ini iaitu seperti berikut:

I. Langkah 1 : Pilih 2 shapefiles yang ingin digabungkan seperti yang ditunjukkan pada
Rajah 3.5

V. [l Sempadan_Kampung_Negeri_ Sembilan
v [l Sempadan Kampung Mebka

Rajah 3.5 : Data Sempadan Kampung Negeri. Sembilan dan Melaka

ii. Langkah 2 : Klik pada menu dan pilih vector > Data Management Tools > Merge
Vector Layers seperti pada Rajah 3.6

Bastet Datiibote Wht Mesh Progessing  bHelp

Geoproceising Tocds spr w o = =

Anadyua Tocls . .

Basearch Tooks

>
|
§ oo sommicser |
.

¥ ion Aol tei By Locamon

Repeggect Lagey ‘

Rajah 3.6 : Memilih Fungsi Merge Vector Layers
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iii. Langkah 3 : Pilih kedua-dua layers untuk digabungkan dan klik butang “RUN” untuk
menggabungkan fail terlibat seperti yang ditunjukkan pada Rajah 3.7.

* Merge vector layers |

SO S

Rajah 3.7 : Melaksanakan Fungsi Merge Vector Layers

iv. Langkah 4 : Pilih shapefiles yang telah digabungkanyang dinamakan sebagai ‘merged’
, Right Click > Export > Save Features As. Simpan fail tersebut (klik pada butang yang
dibulatkan seperti Rajah 3.8)/ sebagai ‘Sempadan Kampung Melaka Negeri 9.
Pastikan pilih ESPG:4326=WGS 84 pada item CRS supaya ia dapat digunakan di
dalam Tableau nanti. Tandakan pada kotak “Add Save Files to Map” dan klik ‘OK’
untuk simpan

g e ' Q
1 Make Permanent.

¢ @ e e S- , 'D‘; e
Propéities. s Layer it le.
I Mergd - o
v Se dan_K. N _Sembilan Sav e OGSL ayer Sl’)| ‘e.
V' [1] Sempadan Kampung Melaka

w Geometry

Rajah 3.8 : Simpan Layers Yang Digabungkan Dalam Format .shp

\2 Langkah 5 : Ulang langkah 4 untuk simpan layers yang digabungkan sebagai
‘Sempadan Kampung Melaka N9’ dalam format .csv dengan memilih ‘Comma
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Separated Value [CSV]’ dalam fungsi ‘Save Vector Layers As’ seperti yang
ditunjukkan di dalam Rajah 3.9

Geopackage :\’
ESRI Shapefile

Q save Vecte o o0

AutoCAD DXF

Format Comma Separated Value (CSV]
File name | Geoconcept
Geography Markup Language [GML]
Layer name | cois0n
RS GeoJSON - Newfine Delimited
GeoRsS
ha F GPX)
Encoding | OFS €Xehange Format (GPX)
INTERLIS 1
INTERLIS 2

» Select fir Keyhole Markup Language [KML]

» Geomets Mapinfo MIF

Mapinfo TAB

Microstation DGN

*» Layer Of )45 Office Open XML spreadsheet [XLSX]

» Custom { Open Document Spreadsheet (ODS]
PostgreSQL SQL dump
S-57 Base file

> Exte

SpatiaLite
sQuite

vV Add saved file to map B | Concel Help

Rajah 3.9 Simpan Layers Yang Digabungkan Dalam Format .csv

Kedua-dua format fail yang dijana ini akan digunakan untuk di dalam pembangunan
papan pemuka di dalam kajian‘ini.

b. Proses Pemurnian dan Eksport Maklumat Bandar

Proses kedua ini-dilaksanakan bagi. memurnikan struktur poligon di dalam

sempadan_bandar.shp supaya dapat meminimumkan kesilapan yang dibuat.

i. Langkah1: Pilih shapefiles yang terlibat seperti Rajah 3.10.

=
%]

Layers
LA GUR A A g
sempadan bandar

Rajah 3.10 : Data Sempadan Bandar
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ii. Langkah 2 : Klik pada simbol Toolbox. Pilih Menu Vector Geometry > Fixed Geometry
> Pilih sempadan_bandar > klik ‘RUN’ seperti yang ditunjukkan pada Rajah 3.11.

= — 1 Processing Toolbox 2% Processing Toolbox 2%
B ¥ ZT =~ > - o N o o
Ic:n-A;.'r) =
A W » @ Vector creation - 3% Filter vertices by Z value =
> Q Vector general | O Fuxgeometnes |
Fsdm_ I ——

#m Add geometry attributes ¥ Ged eridian
¢ Affine transform »: Ged Algorithm ID:
¥ Aggregate B Inte Notive:figeometries
% Boundary
¥ Bounding boxes
" Buffer
*» Centroids
v/ Check validity

P . i

Sarameters | Log Fix geometries I

(o Ty =)0 y
o s |
|
S o - =
Rajah 3.11 ;' Melaksana Fungsi Fixed Geometry
iii. Langkah 3 : Simpan fixed shapefiles tersebut sebagai ‘Sempadan Bandar Fixed’

sepertimana Langkah 4 di dalam Proses A.
C. Proses Mengenalpasti Intersection Antara Kampung dan Bandar

Proses ketiga ini dilaksanakan bagi mengenalpasti intersection di antara kawasan Kampung dan
Bandar:

i. Langkah 1 : Pilih menu Vector > Geometry Tools > Add Geometry Attributes seperti
yang ditunjukkan dalam Rajah 3.12

Raster Database Web Mesh Progessing Help

Geoprocessing Tools d L) - - - 0
Ggometry Tools B v Centroids...

Analysis Tools » | §2 Collect Geometries...
Research Tools » | % Densify by Count...
Data Management Tools » | %" Extract Vertices...

= 3" Multipart to Singleparts...

¢ Polygons to Lines...
Simplify...

@
. + Check Validity...
p @ Delaunay Triangulation...

e Add Geometry Attributes..

P Lines to Polygons...
Bl Voronoi Polygons...

Rajah 3.12 Memilih Fungsi Add Geometry Attributes
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ii. Langkah 2 : Pilih shapefiles ‘Sempadan Kampung Melaka Negeri 9’ yang telah
dihasilkan sebelum ini sebagai Input Layer dan Klik ‘RUN’. Rajah 3.13 menunjukkan
langkah 2 yang dilaksanakan.

' Add geometry attributes

ey D0~ =
Rajah 3.13 Melaksanakan Fungsi Add Geometry Attributes

iii. Langkah 3 : Pilih menu Vector > Geoprocessing Tools > Intersection seperti pada
Rajah 3.14

Qe tly Rastef Database Web Mesh Progessing Help
Geoprocessing Tools £ Buffer...

Geometry Tools e Clip...

Analysis Tools » @ Convex Hull...

Research Tools »| & Difference...

Data Management Tools » | P Dissolve... |

& Symimetrical Differencen.
@ Union...
o Elimina te Selected Polygons...

=
<

Rajah 3.14 Memilih FungsiIntersection

iv. Langkah .4 Pilinh fail<shapefiles ‘Added Geom Info’ pada Input Layer dan pilih
shapefiles ‘Sempadan Bandar Fixed” pada Overlay Layer > Klik Run seperti yang
ditunjukkan pada Rajah 3.15

avwters | teg * Intersection

Rajah 3.15 Melaksanakan Fungsi Intersection

\2 Langkah 5 : Simpan fail shapefiles dalam format .csv untuk digunakan pada proses
Rapidminer kelak. Pilih shapefiles yang dinamakan sebagai ‘Intersection’, Right Click
> Export > Save Features As > CSV  Format sebagai
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‘Intersection_Between_Kampung_Bandar_Details’ dan Klik OK seperti yang
ditunjukkan dalam Rajah 3.16.

Rajah 3.16 Data Intersection Dalam Format .csv
3.3.4 Proses Kerja 2 : Integrasi Data.

Bagi kajian ini, data dalam format shapefiles yang diterjemahkan kepada format .csv
akan dimuatnaik dan diproses di dalam Rapidminer bagi menghasilkan connector yang
akan memegang key attributes bagi kampung dalam bandar. Data yang telah diproses
ini ditulis ke dalam Hive table untuk digunakan di dalam perisian Tableau bagi mereka

bentuk papan pemuka. Rajah 3.17 di bawah menunjukkan aliran data yang digunakan.

Data format .csv HIVE Tableau

*  Sempadan Kg Melaka N9 Comector Ke Papan Pemuka
_____ . I » Rapidnsiner ’ o Melaka N9
¢ Intersection Ant Kg Bandar _dlm_Bandar claka I

Rajah 3.17 : Aliran Data

Rapidminer adalah satu platform data sains yang dapat menyediakan persekitaran bagi
analitik bisnes, perlombongan data (data mining) dan machine learning. Dalam kajian
ini, Rapidminer digunakan dalam proses persediaan data untuk digunakan semasa
pembangunan papan pemuka. Secara keseluruhannya, terdapat tiga proses yang berlaku
di dalam Rapidminer iaitu penerimaan data .csv, penyediaan data dan penyimpanan data
seperti yang ditunjukkan pada Rajah 3.18.
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Rajah 3.18 : Proses Keseluruhan di dalam Rapidminer
a. Proses 1 : Penerimaan Data Format .CSV

Dalam Rajah 3.19 menunjukkan data-data yang telah dijana dalam format .csv sebelum
ini seperti Sempadan_Kampung_Melaka N9.csv (A) dan Intersection_ Between_
Kampung_Bandar_Details.csv (B) dimuatnaik dan dibaca di dalam Rapidminer. Data-

data format .csv tersebut akan disimpan di dalam.server repositori Rapidminer.

d

Read Kampung

n 7:'”1 E‘ om:/
4

|

e

Read Inter section

< 5
n { " ?*l o
b |

Rajah 3.19 : Data format .csv dibaca di dalam Rapidminer
b. Proses 2 : Penyediaan Data

Dalam Proses 2 ini, Rapidminer akan menghasilkan connector untuk digunakan semasa
membangunkan papan pemuka. Tujuan utama connector ini disediakan adalah bagi
memastikan shapefiles gabungan Kampung Melaka dan Negeri Sembilan
(sempadan_Melaka_Negeri_9.shp) dan shapefiles Bandar
(sempadan_bandar_fixed.shp) dapat dihubungkan. Sehubungan itu, data intersection
antara kampung dan bandar (Intersection_Between Kampung_Bandar_Detail.csv)
digunakan sebagai key connector untuk menghubungkan kedua-dua shapefiles yang
dinyatakan. Di samping itu, connector yang dihasilkan akan mempunyai maklumat

kampung yang berada di dalam sempadan bandar (Kampung dalam Bandar). Terdapat
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tujuh langkah yang digunakan bagi proses menghasilkan connector seperti ditunjukkan
pada Rajah 3.20.

b)

d)

f)

Rajah 3.20 : Proses Penghasilan Connector
Langkah 1 : Operator penerima akan menerimadata intersection yang disimpan

daripada repositori server.

Langkah 2 : Intersect Condition akan memproses peratus kawasan terkandung

(intersection area) di antara sempadan bandar dan kampung serta
membandingkan dengankeluasan keseluruhan kampung. Kemudian, ia akan
membuat saringan untuk menentukan kampung yang tidak melebihi peratus
kawasan terkandung yang-ditetapkan. Sepertimana yang telah ditetapkan oleh
FGD, mana-mana kampung yang /dikenalpasti-mempunyai kurang daripada
30% kawasan terkandung daripada keluasan keseluruhan kampung tidak akan

dikategorikan sebagai ‘Kampung Dalam Bandar’.

Langkah 3 : Operator Select Attributes akan memilih key attributes yang

diperlukan data intersection (Intersection_Between_ Kampung_Bandar_

Detail.csv) bagi tujuan penggabungan.

Langkah 4 : Operator Rename akan mengubah nama key attributes yang dipilih
untuk membezakannya dengan shapefiles attribute yang asal termasuklah

id_kampung kepada id_kampung_connector.

Langkah 5 : Untuk memadankan id_kampung yang berada di dalam shapefiles

sempadan_Melaka_Negeri_9.shp, id_kampung_connector  di dalam

Rapidminer ini perlu diubah kepada format nominal (string).

Langkah 6 : Tambah “0” di hadapan id kampung_connector untuk menamatkan
proses perubahan tersebut.
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g) Langkah 7 : Data connector yang diproses akan disimpan di dalam repositori
server Rapidminer dan ditulis ke dalam Hive table dengan nama

connector_kampung_dalam_bandar.

C. Proses 3 : Penyimpanan Data.

Dalam Proses 3 ini, operator akan menulis semua data yang telah siap ke dalam Hive
yang akan digunakan bagi pembangunan papan pemuka menggunakan perisian Tableau
seperti yang ditunjukkan dalam Rajah 3.22.

Connector

[28 ]

2

°

Write pracessed
conpectordata to
rve

Rajah 3.21: Proses Penyimpanan Data
3.3.5 Proses Kerja 32 Reka bentuk Papan Pemuka

Proses Kerja Ketiga di. dalam kajian<inimerupakan Fasa 4 Model CRISP-DM
melibatkan pembangunan papan pemuka dengan menggunakan perisan Tableau. Hasil
daripada pembangunan papan-pemuka ini akan dapat memaparkan persempadanan
bandar dan kampung dalam bentuk peta persempadanan negeri. Pembangunan papan
pemuka menggunakan perisian Tableau akan dihuraikan di dalam Para 3.4 berkaitan

penggunaan perisian Tableau.

3.3.6  Proses Kerja 4 : Penilaian Melalui FGD

Proses Kerja Keempat di dalam kajian ini merupakan Fasa 5 dan Fasa 6 Model CRIPS-
DM. Proses Kerja Keempat ini akan menyemak hasil paparan papan pemuka di mana
persempadanan kampung dalam bandar akan dapat dikenalpasti. Akhir sekali,
perbincangan dan kesimpulan akan di buat berdasarkan kepada keputusan yang telah
diperolehi. Sesi perbincangan bersama Focus Group Discussion (FGD) telah dibuat
bagi mendapatkan pengesahan persempadanan kampung dalam bandar yang telah

dijana di dalam papan pemuka. FGD adalah terdiri daripada lima orang Pegawai
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Perancang daripada PLANMalaysia (Jabatan Perancangan Bandar dan Desa) yang

terdiri daripada beberapa unit seperti Unit Rancangan Fizikal Negara, Unit Dasar

Perbandaran Negara dan Unit Dasar Perancangan Fizikal Desa Negara. Kelima-lima

pegawai yang terlibat adalah merupakan pegawai yang secara langsung terlibat dalam

perancangan fizikal bagi kawasan bandar dan luar bandar. Perkara-perkara yang

dibincangkan melibatkan tiga elemen iaitu:

b)

b)

d)

Reka bentuk Papan Pemuka

Adakah FGD bersetuju dengan susunatur bagi paparan statistik, carta bar dan

peta grafik yang disediakan?

Adakah FGD bersetuju dengan tajuk-tajuk yang digunakan di dalam papan

pemuka?

Adakah FGD bersetuju-dengan skema warna (color scheme) dan jenis dan saiz
font yang digunakan padapaparan papan pemuka?

Interaksi Papan Pemuka.

Adakah berlaku perubahan pada paparan papan pemuka mengikut negeri yang
dipilin?

Adakah berlaku perubahan pada paparan papan pemuka mengikut bandar yang
dipilih?

Adakah berlaku perubahan pada paparan papan pemuka mengikut kampung

yang dipilih?

Adakah berlaku perubahan pada paparan peta apabila FGD menggunakan

fungsi ‘zoom in’ dan ‘zoom out™?

Validasi Data

Adakah FGD bersetuju dengan bilangan bandar, kampung dan kampung dalam
bandar pada statistik yang dipaparkan?
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b) Adakah FGD bersetuju dengan bilangan penduduk pada statistik yang

dipaparkan?
c) Adakah FGD bersetuju dengan paparan bandar yang diplotkan di dalam peta?

d) Adakah FGD bersetuju dengan paparan kampung dalam bandar dan kampung

luar bandar yang diplotkan di dalam peta

3.4 PENGGUNAAN PERISIAN TABLEAU

Kajian ini akan menggunakan perisian Tableau dalam -memaparkan visualisasi
persempadanan bandar, persempadanan kampung dan persempadanan kampung dalam
bandar bagi Melaka dan Negeri Sembilan yang-diterjemahkan dalam bentuk papan
pemuka. Seperti yang dibincangkan di dalam Bab 2, perisian Tableau ini merupakan
salah satu perisian business intelligence (Bl) yang mampu menghasilkan produk
visualisasi data secara interaktif. Sehubungan itu, dengan menggunakan perisian
Tableau ini, rekabentuk papan-pemuka yang interaktif. dapat dibangunkan bagi

memudahkan pengguna untuk membuat keputusan.

Menurut Gartner’s Magic Quadrant; lebih daripada 70 peratus pengguna
Tableau memilih Tableau kerana iamudah digunakan dan asas Tableau boleh dipelajari
serta difahami dalam masa beberapa jam sahaja di samping kemampuannya untuk
menghasilkan papan pemuka yang interaktif. Papan pemuka ini boleh dihasilkan tanpa
memerlukan pengetahuan pengaturcaraan yang kompleks kerana kemudahan drag and
drop yang disediakan. Hal ini menjadikan pengguna merasakan berupaya untuk
menghasilkan sebuah papan pemuka dengan pengalaman pengguna sedia ada.

3.4.1 Versi Tableau

Terdapat beberapa versi Tableau yang digunakan pada masa ini. Tableu Online
merupakan versi Tableau yang mudah digunakan, berasaskan kepada teknologi awan
di mana membolehkan sesebuah organisasi berkongsi visualisasi yang dihasilkan di
dalam Tableau Desktop dengan pengguna lain. Tableau Server pula membolehkan
keupayaan perkongsian yang sama dalam antara muka yang sama tetapi dipasang di

dalam persekitaran server pengguna sendiri dan juga diuruskan oleh pengguna sendiri.
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Kajian ini dilaksanakan menggunakan perisian Tableau versi server kerana
memudahkan pembangunan papan pemuka. Di samping itu, kemudahan perisian
Tableau versi server ini adalah antara kemudahan yang disediakan oleh pihak MAMPU
untuk agensi dalam salah satu inisiatif analitik data raya. Berikut merupakan beberapa

versi Tableau yang digunakan.

a. Tableau Public

Tableau Public merupakan versi percuma Tableau yang boleh digunakan untuk
menghasilkan visualisasi. Versi ini dilihat lebih ekonomikal dan menjadi pilihan bagi
pengguna baru yang ingin mencuba dan mempelajari penggunaan Tableau. Semua
pengguna akan mempunyai akses kepada data-data yang-dihasilkan. Sehubungan itu,
pengguna perlu berhati-hati untuk tidak meletakkan data yang sulit di dalam Tableau
Public.

b. Tableau Desktop

Tableau Desktop adalah-sama seperti Tableau. Public tetapi dalam versi yang perlu
dibeli oleh pengguna kerana ia adalah 'berlesen. Pengguna boleh menghasilkan
visualisasi data, laporan dan papan_ pemuka dalam tempoh masa yang singkat dan
mudah dengan menggunakan Tableau Desktop. Pengguna juga boleh menggunakan
pelbagai sumber data bagi menghasilkan analisis data, mengubah metadata dan memuat

naik workbook yang telah siap dibangunkan ke dalam Tableau Server jika diperlukan.

C. Tableau Online

Tableau Online merupakan versi Tableau yang dihost di Tableau Server. Pengguna
boleh menjadikannya sebagai satu platform perkongsian papan pemuka, berinteraksi
dengan pelaporan yang ada dan mendapatkan pandangan berkaitan. Tiada keperluan
perkakasan dan masa persediaan memandangkan versi ini sepenuhnya menggunakan

teknologi perkomputeran awan

d. Tableau Server

Tableau Server merupakan platform pengurusan yang boleh digunakan secara dalam

talian atau mudah alih yang membolehkan pengguna berinteraksi dengan papan pemuka
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tanpa perlu instalasi di perkakasan pengguna. Tableau Server juga menyediakan fungsi
keselamatan yang kukuh atas papan pemuka bagi visualisasi data. la memanfaatkan

kemudahan pangkalan data yang pantas melalui sambungan secara langsung.

e. Tableau Reader

Tableau Reader adalah aplikasi komputer versi percuma untuk membolehkan pengguna
membuka dan membaca visualisasi data yang dihasilkan oleh Tableau Desktop.

3.4.2 Senibina Tableau

Tableau mempunyai tahap skalabiliti yang tinggi dan senibina n-tier-server yang
memberi perkhidmatan kepada pengguna mudah alih, web dan perisian komputer.

Rajah 3.22 menunjukkan senibina Tableau yang digunakan pada masa Kini.

Cintn Wasshouse  Date Marts [N Coben
Sumber Data @ D % &
Fost Doto SQ& MDX
Penghubung Data Engine Comnector Connector | Repository
I\'nmponen Utama DataServer VizQL Server Application Server

GCF')HII}.{ Gateway / Load Balancer

Pengguna

A e

Desktop Mobile Browser

Rajah 3.22 Senibina Tableau
a. Sumber Data (Data Sources)

Tableau boleh dihubungkan dengan beberapa sumber data tidak kira sama ada daripada
pangkalan data, fail excel mahupun aplikasi web. Tableau juga boleh berhubung dengan
data daripada pelbagai persekitaran malah boleh bekerja secara serentak. Tableau

memberikan alternatif mudah untuk mengemaskini data menjadi pantas dan responsif.
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Penghubung Data (Data Connectors)

Tableau menyediakan beberapa penghubung data untuk pangkala data yang optimum

seperti Microsoft Excel, SQL Server, Oracle, Teradata, Vertica, Cloudera Hadoop dan

lain-lain lagi. Terdapat juga ODBC yang generik untuk sebarang sistem yang tidak

mempunyai penghubung tersendiri (native connector). Tableau menyediakan dua

model untuk berinteraksi dengan data iaitu penghubung-langsung (Live Connection)

dan simpanan-memori (In-Memory). Pengguna boleh menukar antara penghubung

langsung dan simpanan-memori mengikut kehendak pengguna.

a)

b)

Penghubung-Langsung

Menggunakan data sedia ada dengan /menghantar dinamik SQL atau MDX
statements terus kepada sumber pangkalan data berbanding mengimport semua
data. la merupakan analitik bahagian hadapan pengguna kepada banyak
pangkalan data di dunia. Tableau telah mengoptimumkan setiap penghubung

bagi dengan mengambil-peluang kepada karektor unik bagi setiap sumber data.
Simpanan-Memori

Tableau menawarkan prestasi analitik yang pantas dengan enjin data simpanan
memori. Enjin data akan mengekstrak data dan meletakkannya pada simpanan-
memori «di- dalam Tableau.~Enjin data ini akan menggunakan sepenuhnya
keseluruhan sistem untuk mendapatkan tindak balas yang pantas bagi 1 juta
baris data. Enjin data ini juga mampu mengakses storan sepertimana RAM dan

memori cache.

Komponen Utama.

Terdapat tiga server penting di dalam komponen utama Tableau iaitu Server Data (Data

Server), Server Aplikasi (Application Server) dan Server VizQL (VizQL Server).

a)

Server Data

Server Data akan melaksanakan pengurusan secara berpusat dan menyimpan
sumber data Tableau. la juga akan mengekalkan metadata daripada Tableau

Desktop seperti pengiraan, definisi dan kumpulan.



37

b) Server Aplikasi

Server Aplikasi digunakan untuk menyediakan pengesahan dan kebenaran. la
mengendalikan pentadbiran dan kebenaran bagi web serta antaramuka mudah
alih. la juga akan memastikan keselamatan dengan merekodkan setiap id sesi
pada Tableau Server. Bagi memastikan ketersediaan pelayan aplikasi berada
pada tahap yang tinggi, ia perlu dikonfigurasikan contoh (instance) pada setiap

nod di kluster server Tableau.
c) Server VizQL

Server VizQL berperanan sebagai pengubah permintaan daripada sumber data
menjadi visualisasi. Apabila permintaan pengguna dimajukan kepada proses
VizQL, ia akan menghantar permintaan tersebut terus kepada sumber data dan
menerima maklumat dalam bentuk .imej. Imej atau visualisasi ini akan
dipaparkan kepada pengguna. Server Tableau-akan mewujudkan visualisasi
cache bagi mengurangkan masa proses. Cache tersebut boleh dikongsi dalam
kalangan pengguna yang.mempunyai kebenaran untuk melihat visualisasi
tersebut.

d. Gerbang (Getaway)

Tableau Server ‘Utama akan menjejaki permintaan kepada komponen-komponen lain.
Permintaan yang datang daripada pengguna pada mulanya akan memasuki server
gerbang and dihalakan mengikut prosedur yang sesuai. Sekiranya beberapa prosedur
dikonfigurasi untuk mana-mana komponen. Gerbang akan bertindak sebagai
pengimbang (load balancer) dan berkongsi permintaan kepada prosedur-prosedur
tersebut. Manakala bagi konfigurasi server tunggal, setiap prosedur berada pada

gerbang atau server utama.

e. Pengguna

Pengguna akan menggunakan Tableau sama ada melalui web, peralatan mudah alih,
perkomputeran awan mahupun di persekitaran pembangunan sendiri. Pengguna akan
berinteraksi teruatamanya dengan server Tableau untuk mengakses workbooks atau

visualisasi. Pelayar web seperti Safari, Google Crome dan Mozilla Firefox boleh
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membenarkan pengguna mengemaskini kandungan visualisasi melalui papan pemuka
di dalam Tableau Online. Tableau Desktop membantu pengguna dalam menghasilkan
papan pemuka, workbooks dan visualisasi dengan menggunakan data yang diterima
daripada sumber.

Dalam membangunkan sebuah papan pemuka menggunakan perisian Tableau,
tiga perkara asas yang perlu diketahui iaitu hubungan data (data connection),visualisasi
data (data visualization) dan perkongsian data (data sharing) seperti yang ditunjukkan
pada Rajah 3.23. Hubungan data bermaksud menghubungkan data-data yang tersedia
dan diperlukan untuk paparan papan pemuka manakala visualisasi data adalah di mana
data tersebut dianalisis dan dipaparkan dalam pelbagai bentuk seperti carta bar, carta
pai, statistik dan pemetaan. Kemudian setelah data tersebut dipaparkan dalam bentuk
papan pemuka, maka seharusnya ia dikongsi sama ada dengan pihak pengurusan
ataupun pasukan pelaksana agar keputusan yang berkaitan dapat dibuat dengan lebih

tepat. Rajah 3.24 menunjukkan Paparan Utama perisian Tableau yang digunakan.

Rajah 3.23 : Konsep Asas Perisian Tableau

!];q '

E’ﬁ/ T

Rajah 3.24 : Paparan Utama perisian Tableau
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3.4.3 Hubungan Data

Perkara pertama yang perlu dilakukan untuk pembangunan papan pemuka ini adalah
dengan memastikan data-data yang telah diproses sebelum ini dapat dihubungkan ke
dalam perisian Tableau. Rajah 3.25 menunjukkan langkah-langkah yang dilakukan

untuk menghubungkan data-data tersebut.

Rajah 3.25: Langkah-langkah Menghubungkan Data di dalam Tableau

Data-datayang telah diproses sebelum ini telah disimpan di dalam Hive. Justeru, untuk
menghubungkannya dengan perisian Tableau, langkah-langkah berikut perlu
dilakukan:

a) Langkah 1 : Di sebelah kiri paparan utama terdapat panel ‘Connect’. Klik
pada ‘More..” yang berada di bawah menu ‘To a Server’.

b) Langkah 2 : Cari ‘Hortonworks Hadoop Hive’ dan klik seperti dalam rajah.
Tetingkap ‘Hortonworks Hadoop Hive’ akan terpapar.

c) Langkah 3 : Isi maklumat yang diperlukan dan klik pada butang ‘Sign in’.
Paparan seperti Rajah 3.26 akan dipaparkan menunjukkan connection yang
telah di simpan.
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Sempadan_Kampung_Melaka_Negeri_9.shp+ (Muilti...
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Rajah 3.26 : Paparan Data Connection
3.4.4 Visualisasi Data.

Seterusnya merupakan proses reka bentuk papan pemuka bagi visualisasi data yang
telah tersedia. Rajah 3.27 menunjukkan paparan ‘worksheet’ yang akan digunakan

dalam pembangunan papan pemuka ini.

Data Analytics + | Page A ol

Tables

o

Rajah 3.27 : Paparan Worksheet

Di dalam pembangunan papan pemuka ini, terdapat lima elemen visualisasi
yang melibatkan reka bentuk peta, statistik bilangan, carta bar, carta senarai dan

susunatur papan pemuka itu sendiri.

a. Reka bentuk Peta

Dalam reka bentuk peta ini, data yang terlibat adalah daripada data shapefiles iaitu
Sempadan_Bandar_Fixed.shp dan  Sempadan_Kampung_Melaka_Negeri_9.shp.

Paparan peta akan dijana secara automatik apabila field Geometry
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(Sempadan_Bandar_Fixed.shp) diklik sebanyak dua kali. Longitude dan Latitude juga

akan automatik dijana pada columns dan rows di shelves seperti yang dipaparkan pada
Rajah 3.28

7 ===
= = P 1
'..' . * <
«w .,

Rajah3.28 : Paparan Peta SempadanBandar

Bagi rekabentuk paparan peta'sempadan kampung pula; layer ditambah dengan
membuat salinan Latitude yang sedia ada pada rows di shelves. Kemudian, tarik field

Geometry (Sempadan_Kampung_Melaka_Negeri_9.shp) dan masukkan kepada layer
2 seperti yang dipaparkan pada Rajah 3.29.
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Rajah 3.29 : Paparan Layer 2 Untuk Sempadan Kampung
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Rajah 3.30 : Paparan Gabungan Layer

Rajah 3.30 menunjukkan paparan bagi kedua-dua layer yang telah digabungkan.
Bagi membezakan sempadan kawasan bandar, fungsi ‘Create Calculated Field’
digunakan dengan mengubah warna pada sempadan kawasan bandar. Rajah 3.31
memaparkan Paparan Sempadan Bandar yang telah diubah warnanya.

Rajah 3.31 : Paparan Sempadan Bandar

Fungsi ‘Create Calculated Field’ juga digunakan untuk memetakan Kampung
Dalam Bandar dengan penambahan IF statement di dalam fungsi tersebut seperti yang
ditunjukkan pada Rajah 3.32.

Kampung Category

M { ]

The calculation is valid. Apply | ok |
Rajah 3.32 : Paparan IF Statement
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b. Reka bentuk Statistik Bilangan

Dalam mereka bentuk statistik bilangan, fungsi count(distinct) yang terdapat di dalam
Mark Card digunakan. Data diambil daripada field-field yang terlibat bagi membuat
pengiraan bilangan bandar, kampung dan kampung dalam bandar yang telah

dikenalpasti.

Totden an 1arik be Mov
. Sampaten Raner fi

egeten 8 amgnng. B T

Rajah 3.33 : Langkah-langkah Menyediakan Statistik Bilangan Bandar

Rajah 3.33 menunjukkan langkah-langkah yang digunakan untuk menyediakan statistik
bilangan bandar bagi negeri yang.terlibat dalam kajian ini. Pengiraan bilangan bandar
ini dibuat menggunakan kemudahan fungsi count(distinct) yang terdapat di dalam
perisian Tableau. Field parameter yang ingin dikira ditarik ke Mark Card dan fungsi

count(distinct) digunakan.

C. Reka bentuk Carta Bar

Carta Bar digunakan bagi memaparkan bilangan Kampung Dalam Bandar yang
dikenalpasti di dalam sempadan setiap Bandar. Bagi merekabentuk carta bar di dalam
perisian Tableau, fungsi row dan column pada Shelf digunakan bersama dengan fungsi
count(distinct) pada Mark Card. Field Bandar diletakkan pada ruangan row manakala
parameter hasil daripada fungsi count(distinct) untuk Kampung Dalam Bandar
diletakkan pada ruangan column yang terdapat di Shelf seperti yang ditunjukkan pada
Rajah 3.34.
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Klik pada Bandar
dan tarik ke row o

shelf -~ Darvaw

Rajah 3.34 : Langkah-langkah Menyediakan Carta Bar
d. Reka bentuk Carta Senarai

Carta Senarai yang direkabentuk adalah bagi memenuhi keperluan pengguna yang
mahukan bilangan penduduk di setiap kampung dipaparkan. Fungsi row dan column
pada Shelf juga digunakan bersama-sama fungsi sum( ) pada Mark Card. Field
Id_Kampung dan Nama_Kampung diletakkan di ruangan row manakala parameter hasil
daripada fungsi sum( ) diletakkan pada ruangan column:seperti yang ditunjukkan pada
Rajah 3.35.

Kk Nama kg’
fan tark ke

rows di shelf

maorks cord

Rajah 3.35 : Langkah-langkah Menyediakan Carta Senarai
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e. Susunatur Papan Pemuka

Bagi susunatur papan pemuka ini, perisian Tableau mempunyai kemudahan di mana
elemen-elemen yang telah dibangunkan di dalam worksheet boleh dibawa terus ke
dalam platform papan pemuka yang disediakan. Kaedah ‘drag n drop’ memberi
kemudahan untuk membuat susunatur pada paparan papan pemuka sepertimana yang
dikehendaki. Rajah 3.36 menunjukkan bagaimana saiz paparan papan pemuka boleh

ditentukan sama ada secara tetap (fixed size), automatik atau dalam skala (range).

Rajah 3.36 : Menentukan Saiz Papan Pemuka.

Setelah saiz papan pemuka ditentukan, kerja-kerja penyusunan elemen-elemen
rekabentuk yang telah dibangunkan boleh dimasukkan ke dalam platform papan
pemuka tersebut. Rajah 3.37. menunjukkan dua elemen reka bentuk yang telah
dibangunkan, dibawa masuk dan disusun di dalam platform papan pemuka sepertimana

yang dikehendaki.
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Rajah 3.37: Paparan Papan Pemuka

3.4.5 Focus Group Discussion (FGD)

Kajian yang dijalankan adalah berpandukan kepada keperluan dan kegunaan agensi.
Setelah pembangunan papan pemuka ini selesai-dilaksanakan, semakan bersama FGD
perlu dilaksanakan sebelum ia dapat dikongsi samaada di peringkat dalaman mahupun
luaran. Hal ini_bagi memastikan agar bukan sahaja keperluan agensi dapat dipenuhi

tetapi bagi menjamin ketepatan data yang dipaparkan.

Perbincangan bersama FGD yang terdiri daripada lima orang Pegawai
Perancang daripada PLANMalaysia (Jabatan Perancangan Bandar dan Desa) yang
terdiri daripada beberapa unit seperti Unit Rancangan Fizikal Negara, Unit Dasar
Perbandaran Negara dan Unit Dasar Perancangan Fizikal Desa Negara. Kelima-lima
pegawai yang terlibat adalah merupakan pegawai yang secara langsung terlibat dalam
perancangan fizikal bagi kawasan bandar dan luar bandar. dilaksanakan bagi melihat
hasil daripada pembangunan papan pemuka yang telah dilaksanakan. Selain daripada
pelaksanaan pengujian seperti User Acceptance Test dan Final Acceptance Test , FGD
juga telah membincangkan hala tuju pembangunan papan pemuka tersebut dan
merasakan ia perlu diangkat untuk digunakan bagi negeri-negeri lain (Laporan UAT dan

FAT Pembangunan Dashboard Sempadan Kampung Dalam Bandar, 2020).





